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WELCOME

_—AceReader Pro |

Thank you for purchasing AceReader Pro.

Congratulations! You have just purchased a sophisticated yet simple to use, award-winning tool designed to help
you and/or your students become more efficient readers.

In today's fast-paced information age, proficient reading is vital. With widespread access to the Internet, we have
more information to process than ever before. But we still need to transfer the written words we encounter into our
minds the old-fashioned way -- reading. Without effective skills, it's like a pipeline trying to feed into a straw.

We at StepWare are dedicated to developing computer software that helps people of all ages become better
readers --- not only faster, but with increased comprehension, as well. Through our dual-purpose products, we are
able to enhance the productivity and educational needs of all our users.

Our goal is to continue bringing you the highest level of customer satisfaction possible. We are committed both to
enhancing our software and to providing you with the best possible support.

System Requirements

PPC or G3/G4/G5 (recommended) processor
Macintosh OS 9.2.2; built for OS X

8 MB or more built-in RAM (memory)

15 MB free disk space

CD-ROM Drive (only needed if installing from CD)

Installation Instructions

1. Insert CD
2. Drag the “AceReader Pro” folder to your Hard Drive.
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INTRODUCTION

Quick Start Guide

Congratulations, you're on your way to becoming an efficient reader! AceReader Pro is an award-winning software
program that can help you unlock your full reading potential. The program contains three essential tools in one
package: (1) a Reading Assessment Tool to determine and track your current reading speed and level; (2) a
Reading Improvement Training Tool to help increase your reading speed and comprehension (both online and
offline); and (3) an Online Reading Tool to help you read more efficiently while online.

About the Startup Wizard Screen:

The Startup Wizard Screen will launch you into common areas of the program. By default it is the first screen
you will see when you start the program. However, since there is an option not to show that screen at startup,
you can also start it from the Help menu: Start Wizard.

Reading Improvement Quick Start Overview:

Recommended Usage Summary: (1) Take a Self-Paced Comprehension Test once a day (i.e. at the beginning
of your training session). (2) Spend 20 to 40 minutes per day with the Drills and/or Expert Mode, with periodic
Game breaks. (3) Keep in mind: Success comes from Positive Attitude, Patience and Practice. You can do it!

Your Base Reading Speed (BRS) is determined from your most recent “qualified” self-paced reading
comprehension test result. Your Base Reading Speed is the speed in which you read the story while taking the
test. Test results are “qualified” using criteria specified by Admin options.

Some of the Drills will pace you at speeds relative to your personal Base Reading Speed. Your speed and
comprehension will be logged so that you can monitor your progress over time.

Whenever you're selecting a Test or Drill, you will be presented with lists. The lists are ordered from simplest
to hardest. You will typically start at the beginning of the lists and work your way down.

When performing the Drills, don't worry about your comprehension. Instead, you want to concentrate on
following the words with your eyes. The Drills are mainly eye exercises. Comprehension will improve over
time.

AceReader Pro is designed for students at all grade levels, as well as adults. The amount of improvement
varies from person to person; however, with diligent use this program allows most people to double and even to
triple their reading speeds while maintaining or improving their comprehension. The amount of time it takes
you to reach your reading goals will depend on the amount of time you put in to it, but you can usually expect
measurable improvement within a few days. You will probably find the time you need to spend with the
program decreases as your reading speed and comprehension increases. Even after you reach your goals,
you may want to use AceReader Pro periodically to maintain your reading skills.

Online Reader Quick Start Overview:

The Online Reader is one of the most powerful features of this product, since it allows you to read more
efficiently while working or surfing online. The Online Reader is also great for training -- you have full control
over your reading material, pacing speeds and option settings. You can load plain text files or reading material
from the clipboard. The clipboard makes it possible to load interesting material from other sources (i.e. Web
pages, e-mail, word processing documents, etc.).

For More Detailed Help:
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Refer to the About AceReader Pro for a more detailed overview.
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About AceReader Pro

Introduction and Overview:

AceReader Pro will help you assess and improve your reading skills. In today's fast-paced information age it
is more important than ever to be a proficient reader. Students at all levels (grades 1-12 plus adults) will benefit
from using this program. AceReader Pro does not teach you how to read, but instead it allows you to unlock
your full reading potential, both on and off the computer.

Determining your Reading Speed (Reading Assessment Activities):

You assess your current reading level through the use of Timed Comprehension Tests. The
Comprehension Tests that come with the program are broken out for grade levels 1-12 plus adult. You can
take Self-Paced Comprehension Tests to determine your Base Reading Speed. You can also take
Forced Speed/Mode Comprehension Tests to determine how well you comprehend material when being
forced to read at certain speeds and modes. The program logs and graphs the test results (comprehension
scores, reading speed, etc.) for accountability.

In addition to the Comprehension Tests that come with the product, you can import Comprehension Tests
created with the Deluxe version of AceReader Pro.

Increasing your Reading Speed (Reading Improvement Activities):

The Drills and Games use Tachistoscope technology to improve your reading skills (both speed and
comprehension).

Drills are based on fundamental and sound pacing principles. The Drills will pace your eye movement
relative to your Personal Base Reading Speed (determined by taking Self-Paced Reading Comprehension
Tests). As you improve, the Drills will automatically become more challenging. The reading material for
each Drill that comes with the program is broken out for grade levels 1-12 plus adult.

Playing the Games will also improve your reading skills and allow you to have fun at the same time. The
Games will flash text and challenge you on your ability to recall, recognize and comprehend the presented
text at various speeds. All the Games have game levels and option settings that allow you to keep yourself
challenged as you improve.

In addition to the Drills and Games, you can also use the Online Reader & Expert Mode to train in manual
mode. Manual mode allows you to train with full control of your training sessions. You can train with your
own text (i.e. from web page, word processing documents, e-books...) and with your own option settings
(i.e. display mode, speed...).

The reading improvement activities are designed to address the problems listed in the “Problems
AceReader Pro Solves” section below.

Online Reader & Expert Mode:
The Online Reader is one of the most powerful features of AceReader Pro. This mode allows full access to
all the program'’s features and options. Enter this mode if you want to (1) use AceReader Pro as a tool to
help you read more efficiently while online; (2) train in manual mode; or (3) perform administration
functions.

About the Network Version:
The Network version is designed for reading lab and networked computer environments. It can be installed

on individual computers or on a network. If installed on a network, students do not need to sit in front of the
same computer for each session and teachers can monitor their progress from any computer on the
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network. Central administration functions allow teachers to view graphical and statistical comprehension
test results for all students. Teacher administration functions include: User Management, Custom Options
Management, Drill Text Management, Drill Management, Comprehension Test Management and Game
Management.
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Problems AceReader Pro Solves:
AceReader helps you become a more proficient reader by helping you:

(1) Reduce Subvocalization (pronouncing or whispering the words in your mind while you read)
You typically can only subvocalize about as fast as you can talk. The program pushes you to read at
higher speeds through pacing techniques. At these higher speeds, it is physically impossible to
subvocalize.

(2) Eliminate Regression (allowing your eyes to wander back to re-read text)
The program will display words in a manner that will help encourage forward-only eye movement.
Words are presented without the surrounding text being shown at all. This promotes forward-only eye
movement since there is no previous text visible.

(3) Reduce Your Eye Fixation Time
Reducing the time spent when your eyes are focused on a single point.

(4) Expand Your Eye Fixation Zone
Improving your ability to read a wider text width when your eyes are focused on a single point.

(5) Increase Your Re-Fixation Speed
Improving your ability to reposition your eyes at a rapid rate.

Technologies Used:

AceReader utilizes two technologies: (1) RAPID SERIAL VISUAL PRESENTATION (RSVP) and (2)
TACHISTOSCOPIC SCROLL PRESENTATION (TSP). When AceReader is in RSVP mode, text is displayed
in the center of the text area. RSVP can help you to read faster than normal because your eyes do not need to
move. In RSVP mode, the words come to your eyes instead of your eyes going to the words. When
AceReader is in TSP mode, text is displayed in a manner that forces your eyes to move just like they do in
normal reading. TSP can train you to read in a normal fashion and at higher speeds. Both modes can help you
learn to take in multiple words at a time.

AceReader Pro can handle text in European languages as well as English since it supports the international
ASCII character set.

AceReader Pro also utilizes additional, patented technologies that have been incorporated into the main screen
options and controls.

Primary Ways to Use AceReader Pro:

* Reading Assessment Tool - To determine and track your current reading speed and comprehension.

* Reading Improvement Tool - To help increase your reading speed and comprehension (both online and
offline).

* Online Reading Tool - To help you read more efficiently while working or surfing online.

Innovative Ways to Use AceReader Pro:

* Dyslexia Aid - Adjust your reading by selecting slower speeds or by bursting sentences one word at a time.

e ESL Aid - Use AceReader Pro to help learn English as a Second Language by improving your English
reading skills.

* Eye Tracker - Train your eyes to move left-to-right and top-to-bottom by using the "Eye Trainer Mode." This
mode forces your eyes to move as they would in normal offline reading.
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Foreign Language Instructor - Use AceReader Pro as a computerized flash card system to read and re-
read text for the purpose of learning a foreign language. AceReader Pro supports the international ASCII
character set (i.e. English, Spanish, German, French, Italian, etc.).

Memorization and Flash Card Tool - Use AceReader Pro's Flash Card Game to memorize learning
material (i.e. state capitals, multiplication tables...). You can also use the Burst Forward and Burst Repeat
features to rapidly read and re-read text for the purpose of memorizing it.

PhotoReading Aid - Use AceReader Pro to flash whole pages of text at desired speeds to assist with online
PhotoReading techniques.

Self-Improvement Programmer - Step up the speed and rapidly display messages to yourself to program
your subconscious with positive suggestions.

Speed Reading Aid - Use AceReader Pro to assist your eye tracking at configured speeds. This will help
you break common bad reading habits that slow you down (i.e. subvocalization and regression).
Tachistoscope — Use AceReader Pro as a pacing tool. Some teachers have noted that AceReader Pro is a
modern-day software version of the mechanical tachistoscope machines from years ago. Those machines,
which would flash text onto a screen at configurable speeds, were used to help many students and teachers
learn how to read better by pacing their eye movement. AceReader Pro goes beyond their capabilities,
though, by providing many additional options and features and it includes the ability to track student progress.
Vision Aid - Change the text font and background color to help see more clearly and to read without eye
movement.

Warm Up - Use AceReader Pro to warm up your reading skills before switching over to read online or offline.
Warming up can help increase your reading speed.

Benefits of Using AceReader Pro:

Better grades in school. Children learn the skills that will pay benefits throughout high school and college
and into the workplace.

Better performance on the job, where reading skills are increasingly important.

More free hours in your life as your reading speed increases.

Better quality of life as your reading, comprehension and retention grow year after year.
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What Makes AceReader Pro a Pro

We designed AceReader Pro by listening closely to what our customers had to say about our original AceReader
program. Here is a list of the AceReader Pro’s current highlights and improvements:

Advanced Burst Options - Provides you with more ways to specify the amount of text that will be
displayed before stopping.

Advanced Speed Controls - Allows you to set up the front screen speed control so it will have whatever
low, high and target speed you want. The speeds are specified in terms of WPM (Words per Minute),
CPS (Characters per Second) or CPM (Characters per Minute). The character-based speeds are useful if
you want long words to display for longer periods of time than shorter words. You also have the ability to
fine-tune your speed with a variety fine tune options (i.e. fixed speed, delays ...).

Bookmark Capability - Allows you to set and go to bookmarks. You can even perform a special function
that will load a file and position you to a bookmark. This is useful for resuming your reading at the point
you left off during the previous session.

Comprehension Test Editor - Provides the ability to create and edit your own reading comprehension
tests. Note: This feature is available with the Deluxe versions only.

Comprehension Tests (now 260 in total) - Includes 20 reading comprehension tests at each grade level
1-12, plus an additional 20 at an adult reading level for a total 13 X 20 = 260 reading comprehension tests.

Custom Preset Options - Allows you to set the options the way you want and then to save and restore
them. This gives you the power to get the program set up quickly according to the type of reading you
want to do. These preset custom options can also be used to define the Drills using the Drill Editor.

Customizable Hotkeys - Allow you to map the functions you use most often used with the keyboard keys
of your choice.

Drill Editor — Provides the ability to create and edit your own drills. Note: This feature is available with the
Deluxe versions only.

Drills, Drills and more Drills - Lead you through the process of performing reading exercises. These
Drills use reading material that is separate from the reading material used with the Comprehension Tests
and they are ordered from easiest to hardest. They have also been grade-leveled.

Games (challenging and fun!) - Help you read more material in less time by reducing your eye fixation
time and by expanding your eye fixation zone. One of the games is a Flash Card game which has the
dual purpose of helping your reading speed and comprehension and memorizing learning material (i.e.
state capitals, multiplication tables ...).

Game Editors - Allows you to incorporate your own game text. Especially handy for the Flash Card game.
Note: This feature is available with the Deluxe versions only.

Import and Export Content Ability - Allows the AceReader Pro community to share Reading
Comprehension Tests and Drills created using the built-in Editors.

Manual Timer - Allows you to pace yourself and have your speed automatically calculated.

Network Version - Designed for reading lab environments. With the network version, students do not
need to sit in front of the same computer for each session and teachers can monitor the progress of the
students from any computer on the network. Central administration functions allow teachers to view
graphical and statistical comprehension test results for all students. Teacher administration functions
include: User Management, Custom Options Management, Drill Text Management, Drill Management and
Comprehension Test Management. Note: This feature is available with the Deluxe Network version only.

Read Timer — Keeps track of your actual reading/training time.

Readability Statistics Analysis Tool - Included for both the Comprehension Test Editor and the Drill Text
Editor. The Readability Statistics Analysis Tool will help you determine the proper grade level of the
reading material. Note: This feature is available with the Deluxe versions only.

Startup Wizard Screen - Launches you into commonly used areas of the program and makes the program
much more intuitive to use.

User Interface - Provides a way to hide/show the controls by displaying mouse-over help. The front
screen now shows a running average for your reading speed in terms of WPM (Words per Minute) and it
contains an Estimated Time of Completion indicator to help you determine how long it will take to
complete your reading.
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USING ACEREADER PRO

Ergonomic Suggestions

While training, patience and a positive attitude are essential!

Use the following hints to maximize your progress:

1.

2.

Keep your shoulders level and relaxed and align them with your ears and hips.
Keep your elbows close to your sides (when typing/using mouse) and your knees lower than your hips.

Keep your head tilted slightly downward. With your feet on the floor or on a footrest, hold your head
upright and look straight at the monitor. The top of your screen should be at or below eye level.

Make sure your screen is clean, with no window glare.

Try to create a good learning environment. That means eliminating as many distractions as possible -- i.e.
turn off phone, turn off e-mail notification, turn off music, remove paperwork from field of vision.

Take a few deep breaths and make sure you're positioned and ready to concentrate before you start each
Drrill.

Remember to blink. When people read from a computer, they tend to blink less than from a printed page.
That can lead to discomfort such as eye burning, tearing or drying out.

. Take a break at least once every hour by standing and stretching for about 30 seconds.

. Make the commitment to practice every day. The more you do, the faster and more easily you'll become a

Speed Reader!
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Reading Assessment

Take Comprehension Test
(Self-Paced)

To take a Self-Paced Comprehension Test, select Take Comprehension Test (Self-Paced) from the Startup
Wizard Screen or select the Take Comprehension Test (Self-Paced) menu item.

Select a Comprehension Test Set and a specific Comprehension Test within the set. Press the Begin
Comprehension Test button to start. The program will lead you through the rest of the process.

Perform this type of test to set your Base Reading Speed. Some of the Drills will utilize your Base Reading
Speed to set the speed. You should perform Self-Paced Comprehension Tests periodically (i.e. once a day at
the beginning of your training session) so your Base Reading Speed is kept up to date and so you can monitor
your progress over time.

With this type of test, the text will appear in "normal fashion" (without flashing). The reading will be followed by
a set of comprehension test questions. The reading portion of the test is self-paced, but you will be timed. The
program will log your speed and comprehension scores for use in the Drills.

Your reading speed is always logged. It is possible to flip back and forth between the story and the quiz.
However, the total time you spend reading the story will accumulate and it is this total figure that will be used to
calculate your reading speed.

Canceled tests are also logged. When viewing test results, you will be able to tell if the test was canceled by
looking at the Comprehension Test Score. The Comprehension Test Score for tests that were canceled will be
marked with “---“. Knowing if a test was canceled is useful to keep track of how much time you spent
familiarizing yourself with the story before you completed the actual test. The graphs only plot data for
completed tests.

AceReader Pro comes with its own set of Comprehension Tests that are broken out by grade levels 1-12 plus
an adult level. Test Sets that come with the program are marked with a “#” as the first character of their name.
These tests are ordered from easiest to hardest. Each time you take a test, the program will
remember/highlight the last test you took. We recommend that you pick a starting level (typically the first level)
and each time you take a test, simply work your way down the list.

Note: For the tests that come with the program, the levels were determined by running the test stories through
common readability formulas. Reading speed is not factored into the leveling. It is best to think of the leveling
as “complexity levels” as opposed to “grade levels.” It is not necessary to stick with tests that map to your age
and/or grade level. Keep in mind, for example, that newspapers are read by adults, but they are typically
written at about the 6" to 8" grade level. You may therefore want to use the levels to help determine the
highest level appropriate for your test taking. In other words, an adult might want to use all the levels, but a 5th
grader may only want to use levels 1-8.

Note: You can import additional sets of Comprehension Tests that were created with the Deluxe version of
AceReader Pro.
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Take Comprehension Test
(Forced Speed/Mode)

To take a Forced Speed/Mode Comprehension Test, select Take Comprehension Test (Forced
Speed/Mode) from the Startup Wizard Screen or select the Take Comprehension Test (Forced Speed/Mode)
menu item.

Select a Comprehension Test, an Option Setting and a Target Speed. Press the Begin Comprehension Test
button to start. The program will lead you through the rest of the process.

Perform this type of test to determine how well you comprehend the reading material when forced to read in
different modes and at different speeds. The text will appear as defined by the Options and Speed you specify.
The program will log your speed and comprehension scores.

Canceled tests are also logged. When viewing test results, you will be able to tell if the test was canceled by
looking at the Comprehension Test Score. The Comprehension Test Score for tests that were canceled will be
marked with “---“. Knowing if a test was canceled is useful to keep track of how much time you spent
familiarizing yourself with the story before you completed the actual test. The graphs only plot data for
completed tests.

AceReader Pro comes with its own set of Comprehension Tests that are broken out by grade levels 1-12 plus
an adult level. Test Sets that come with the program are marked with a “#” as the first character of their name.
These tests are ordered from easiest to hardest. Each time you take a test, the program will
remember/highlight the last test you took. We recommend that you pick a starting level (typically the first level)
and each time you take a test, simply work you way down the list.

Note: For the tests that come with the program, the levels were determined by running the test stories through
common readability formulas. Reading speed is not factored into the leveling. It is best to think of the leveling
as “complexity levels” as opposed to “grade levels.” It is not necessary to stick with tests that map to your age
and/or grade level. Keep in mind, for example, that newspapers are read by adults, but they are typically
written at about the 6" to 8" grade level. You may therefore want to use the levels to help determine the
highest level appropriate for your test taking. In other words, an adult might want to use all the levels, but a 5th
grader may only want to use levels 1-8.

Note: You can import additional sets of Comprehension Tests that were created with the Deluxe version of
AceReader Pro.

View Comprehension Test Results

To view your personal Comprehension Test Results, select View Comprehension Test Results from the
Startup Wizard Screen or select the View Comprehension Test Results menu item.

Your Base Reading Speed and test results are shown. You can view your test results in two forms: (1) a list
sorted by date and time and (2) graphs of your speed and comprehension. The graphs are lined up so you can
see how your speed and comprehension correlate.

It is important to view your Comprehension Test Results periodically so you can track your progress. Your test
results are stored in a database and you can view them at any time.

Note: You can specify filters by clicking the Filter Options... button. Filter options allow you to filter out certain
test results. Examples of test results that you may want to filter out: (1) test results for tests that have been
repeated, (2) test results for tests that have been previously canceled, (3) test results for self-paced tests that
indicate extremely low or extremely high reading speeds (i.e. user was distracted or walked away from program
or quickly clicked the Done button while the story was being presented during a self-paced reading
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comprehension tests)... The default setting is recommended and will help you monitor valid test results over
time.

Note: You can also export test results to a file for further processing and/or printing. See section: User
Management for more information.

Example Test Results Graph:

Test Result Graphs For: Mr. AceReader
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Reading Improvement

Perform Drills

To perform a Drill, select Perform Drills from the Startup Wizard Screen or select the Perform Drills menu
item.

Select a Drill Set and a specific Drill within the set. Press the Begin Drill button to begin.

AceReader Pro Drills are designed to help you improve your reading skills. They are based on sound reading
principles and many years of educational research. In fact, many teachers refer to AceReader Pro as an
"improved version” of the mechanical tachistoscope machines from years ago. Dirills simply flash text at pre-
defined speeds and in specified modes. You can think of Drills as “eye exercises” that flash text to pace your
eye movement and help you break common bad reading habits.

Specifically, Drills focus on helping you break two bad habits: (1) Subvocalization (pronouncing the words in
your mind while you read) and (2) Regression or Re-Reading (letting your eyes wander back so that you re-
read text you previously encountered). The program pushes you to read at higher speeds by displaying text as
flashing word sets. At these higher speeds you will be physically unable to subvocalize and by being forced to
read ahead you will not have the opportunity to re-read. At the high rates you will initially want to worry
less about your comprehension and more about your eye movement. Once you feel more comfortable
with the new techniques, you'll find that your comprehension will improve, as well.

Drills that set the pacing speed relative to the user’s Base Reading Speed require the results from a Self-Paced
Reading Comprehension Test. After every 10 Dirills, you will be prompted to take another Self-Paced Test.

AceReader Pro comes with its own set of Drills (refer below to discussions about each Drill Set that comes with
the program).

Note: You can import additional sets of Drills that were created with the Deluxe version of AceReader Pro.

The following discussion provides background rationale behind the Push to Double Speed Drill Set:

The Push to Double Speed Drills are ordered from easiest to hardest. We recommend that you perform
the Drills in the same order as they are presented in the list.

These Drills begin by flashing text at your Base Reading Speed. They gradually increase to double the
Base Reading Speed, then step back down to 1.2 times that speed. The same text is used throughout
each Drill. The idea is to push you to higher rates, then back down to something slightly faster than the
Base Reading Speed. At that point the 1.2 times reading rate will seem slow compared to the double
speed, even though it is faster than the Base Reading Speed. This allows you to step-stone your way to
faster and faster speeds.

Note: You should perform Self-Paced Comprehension Tests periodically so your Base Reading Speed is

kept up to date and so you can monitor your progress over time. As your Base Reading Speed increases,
the Drills will automatically adjust to push you to faster speeds.

The following discussion provides background rationale behind the Push to Triple Speed Drill Set:

This set of Drills is a more aggressive version of the "Push To Double Speed" set.

The Push to Triple Speed Drills are also ordered from easiest to hardest. We recommend that you perform
the Drills in the same order as they are presented in the list.
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These Drills begin by flashing text at your Base Reading Speed. They gradually increase to triple the Base
Reading Speed, then step back down to 1.2 times that speed. The same text is used throughout each Drill.
The idea is to push you to higher rates, then back down to something slightly faster than the Base Reading
Speed. At that point the 1.2 times reading rate will seem slow compared to the triple speed, even though it
is faster than the Base Reading Speed. This allows you to step-stone your way to faster and faster
speeds.

Note: You should perform Self-Paced Comprehension Tests periodically so your Base Reading Speed is
kept up to date and so you can monitor your progress over time. As your Base Reading Speed increases,
the Drills will automatically adjust to push you to faster speeds.

The following discussion provides background rationale behind the Eye-Robic Progression Drill Set:

The Eye-Robic Progression Drills are ordered from easiest to hardest. We recommend that you perform
the Drills in the same order as they are presented in the list.

There are three separate readings for each of the 13 levels in AceReader Pro: Beginner, Intermediate and
Advanced. The Drills move you progressively through your reading. Each Drill Set contains several
sessions and consists of: (1) Eye-Robics, an eye-exercise to help smooth out the reading process and (2) a
number of Drills.

As you progress through the Dirills, the text will be set to different sizes, styles, colors and speed of
presentation. The first Drill of each reading is set at a speed slower than your Comprehension Test Speed.
This gives you an opportunity to become accustomed to the presentation. As you progress through the
Drills, the presentation rate also increases. The final Drill of most of the readings consists of the full text.
This allows you to read through the document without interruption and at a higher speed.

Play Eye-Span Game

To play the Eye-Span Game, select Play Eye-Span Game from the Startup Wizard Screen or select the Play
Eye-Span Game menu item.

Press the Space Bar key to start and stop the game. Press the Left Arrow key to indicate that the flashed
words are NOT the same. Press the Right Arrow key to indicate that the flashed words ARE the same.

The object of the game is to earn 10 smiley faces. You earn smiley faces when the number of your correct
answers exceeds the number of your incorrect answers. You can change the Options settings to make the
game more or less challenging.

The Eye-Span Game will help you: (1) Reduce Your Eye Fixation Time (the time spent when your eyes are
focused on a single point), (2) Expand Your Eye Fixation Zone (the ability to read a wider text width when
your eyes are focused on a single point) and (3) Increase Your Re-Fixation Speed (the ability to reposition
your eyes at a rapid rate). These are skills that are required to become a proficient reader.

Note: You can import additional game text that was created with the Deluxe version of AceReader Pro.

Play Eye-Span-Comprehension Game

To play the Eye-Span Comprehension Game, select Play Eye-Span-Comprehension Game from the Startup
Wizard Screen or select the Play Eye-Span-Comprehension Game menu item.
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Press the Space Bar key to start and stop the game. Press the Left Arrow key to indicate that all the flashed
words are NOT related in meaning. Press the Right Arrow key to indicate that all the flashed words ARE
related in meaning.

The object of the game is to earn 10 smiley faces. You earn smiley faces when the number of your correct
answers exceeds the number of your incorrect answers. You can change the Options settings to make the
game more or less challenging.

The Eye-Span Comprehension Game is similar to the Eye-Span Game except it has a "Comprehension"
element to it. It will help you increase your eye span and eye fixation speeds while you are also being forced to
think about the meaning of the words flashed on the screen.

Note: You can import additional game text that was created with the Deluxe version of AceReader Pro.

Play Tachistoscope Flash & Recall Game

To play the Tachistoscope Flash & Recall Game, select Play Tachistoscope Flash & Recall Game from the
Startup Wizard Screen or select the Play Tachistoscope Flash & Recall Game menu item.

Press the Space Bar key to flash text. After the text has flashed on the screen, you need to answer the
guestion that appears on the screen to validate that you were able to read and recall the text. This game helps
demonstrate how fast you are able to read when presented with a short burst of text. It also increases your eye
span and eye fixation speeds.

The object of the game is to earn 10 smiley faces. You earn smiley faces when the number of your correct
answers exceeds the number of your incorrect answers. You can change the Options settings to make the
game more or less challenging.

Note: You can import additional game text that was created with the Deluxe version of AceReader Pro.

Play Flash Card Game

To play the Flash Card Game, select Play Flash Card Game from the Startup Wizard Screen or select the
Play Flash Card Game menu item.

Press the Space Bar key to flash text. After the text has flashed on the screen, you will be presented with a
guestion that you need to answer.

The object of the game is to earn 10 smiley faces. You earn smiley faces when the number of your correct
answers exceeds the number of your incorrect answers. You can change the Options settings to make the
game more or less challenging.

The Flash Card Game is similar to the Tachistoscope Flash & Recall Game except it has a "Comprehension”
element to it. You can also use it to memorize learning materials such as Times Tables, State Capitals... Note:
As with all the Tests, Drills and Games, the administration functions allow you to incorporate your own practice
material into the program.

Note: You can import additional game text that was created with the Deluxe version of AceReader Pro.

Play Search/Scan Game

To play the Search/Scan Game, select Play Search/Scan Game from the Startup Wizard Screen or select the
Play Search/Scan Game menu item.

With the Search/Scan Game, you will search for a pre-specified word or symbol within a list or body of text.
Take note of the text for which you are searching, then press the Space Bar to start. Click on the text for which
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you are searching before the specified time runs out. You can press the arrow keys (or X for page down, Z for
page up) to navigate forward and backward one page at a time.

The object of the game is to earn 10 smiley faces. You earn smiley faces when the number of your correct
answers exceeds the number of your incorrect answers. You can change the Options settings to make the
game more or less challenging.

Searching/Scanning is something we do many times in our daily lives (i.e. looking up phone numbers, recipe
ingredients, research...) and the game can help you become more skilled at this common daily activity.

Note: You can import additional game text that was created with the Deluxe version of AceReader Pro.

Online Reader & Expert Mode

Online Reader & Expert Mode Overview

The Online Reader & Expert mode allows full access to all the program features and options. Enter this mode
if you want to (1) use AceReader Pro as a tool to help you read more efficiently while online; (2) train in manual
mode; or (3) perform administration functions.

Refer to the following sections for more information:
* Using AceReader Pro as an Online Reading Tool
e Training in Manual Mode
* Administration Overview

Using AceReader Pro as an Online Reading Tool

AceReader Pro is the ideal Online Reading Tool. Many people use AceReader Pro to read faster and more
efficiently while online. Others find AceReader Pro's unique way of presenting text an easier and more
enjoyable way to read. Still others find it useful as a Productivity Tool.

You can load text from plain-text files and also from the clipboard. By using the clipboard, you can read Web
pages, e-mail, word-processing documents, etc. And you can change many options (number of words to
display per screen update, fonts, font size, font color, background color, margins, speed, delays, etc.) to
enhance your online reading.

You can set the options to display text one word (or a few words) at a time in the center of the screen at high
rates of speed. In this mode, the words are coming to your eyes instead of your eyes going to the words.
Many people find reading in this mode much more efficient.

Refer to the General Usage Overview section for details on how to use AceReader Pro in this mode. Basically,
you will be (1) loading text into AceReader Pro; (2) setting the options the way you want; and then (3) pressing
the Play/Stop buttons to start and stop the text presentation.

You may also find it useful to refer to the Help section titled Main Screen Navigation. It contains a picture of the
main screen and you can click on different areas of the picture to get short descriptions of each component.

Below is a list of features that will be useful when using AceReader Pro as a Productivity Tool:
Bookmarks:

You can use bookmarks as an easy way to return to saved locations in your reading material. The
AceReader Pro bookmark feature operates in much the same way as bookmarks do in the real world.
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Bursting (Front Screen Features):
You can use the Burst feature to read a set number of words or sentences at your current speed before
stopping and you can customize the amount of text that is displayed. Refer to the "Set Burst Options"
sub-section within the "Options Menu" section for more detail on configuring this feature. One way to
use the Burst feature is to set the speed high and also to set some fine tune speed options (i.e. Long
Word Delays). You can quickly burst through chunks of text, then, depending on your comprehension,
you can press the "Forward” and/or "Repeat" Burst buttons to continue your reading.

Center Text Mode Option:
You can read better and faster while online using the "Center Text Mode" (found under the “Options”
menu). In "Center Text Mode" the words come to your eyes instead of your eyes going to the words.
Text is presented in the center of the screen and you can focus on it with minimal eye movement.

Clipboard:
You can use the clipboard as a tool to load text from other applications (i.e. your favorite word
processor, Web browser, e-mail client, etc.).

Custom Options:
You can save your current option settings under a name of your choice. Then, whenever you want to
return AceReader Pro to those settings, you can simply select that custom option. You may find this
useful if you like to use different option settings for different reading material.

Estimated Completion Time (Front Screen Feature):
You can estimate how long it will take you to complete the current document by giving this front screen
indicator your current position and speed setting. This can help you manage your reading time.

Other Options Settings:
You can choose from many other options to make your online reading experience more efficient and
enjoyable: (1) font color; (2) font size; (3) background color; (4) display mode; (5) fine tune speed
options (i.e. delays) and much more. You will find all these options under the "Options" menu.

Pre-Set Productivity Modes:
You can select a preset productivity mode from the "Productivity Mode Default Option Settings"
submenu found under the "Preset-Options" menu. Selecting any of the menu items found under the
"Preset-Options" menu will set all the program options. After you choose a productivity mode, you can
make further adjustments by going to the "Options" menu.

Programmable Hotkeys Option:
You can assign keyboard keys of your choice to common functions (i.e. start/stop toggle, loading
AceReader Pro with the clipboard, etc.). This makes performing common functions easier and quicker
since you do not need to use the mouse or factory-set hotkeys.

Sentence Search (Front Screen Feature):
You can move your current reading position to the beginning of the next sentence that contains the
word (or phrase) you are searching for. This is a hon-case-sensitive search. You can perform the
search on the text within the currently loaded document, either while stopped or while the text is being
flashed. To perform this type of search, first type in the word (or phrase) you want to find in the input
field next to the "Sentence Search" button then press the “Sentence Search” button.

Upper Left Mode Option:
This mode is similar to the “Center Text Mode” (refer above), except the text will always be presented
with a fixed starting position (upper left margin tab position).

Training in Manual Mode
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In addition to performing formal Drills and playing the Games, you can use AceReader Pro in a less structured
way to train and improve your reading skills. The Online Reader & Expert Mode (otherwise known as Manual
Mode) provides you with full control over how you train.

To use the product in manual mode:

1. Load text material into AceReader Pro using plain text files, the clipboard or other training material found
under the File menu. By using the clipboard, you can select your own, varied reading material, such as
Web pages, e-mail, word-processing documents, etc.

2. Set the options (found under the Options menu or Preset-Options menu).
3. Set the speed by clicking on the speed bars (lower left of the main screen).
4. Press the Play/Stop buttons to start and stop the text flashing.

You can set the options to display text left-to-right and top-to-bottom to force your eye movement, just as you
do with normal reading. You can also change many options, such as speed, number of words to display per
screen update, font, font size, font color, background color, margins, speed and delays. Refer to the sections
titled: General Usage Overview and Main Screen Navigation for details on how to set up and perform these
functions.

We recommend training in this mode by pushing yourself way beyond your “comfortable” reading speed, then
slowing back down to a speed slightly faster than that speed. Over time, your comfortable reading speed will
increase. This allows you to step-stone your way to faster and faster speeds.

Recommended Training Technique: First take a Self-Paced Reading Comprehension Test to determine your
Base Reading Speed. Then try practicing at 1X, 2X and even 3X your Base Reading Speed. At 3X, the speed
will seem very fast, but that's okay; just try to keep your eyes on the text. At high rates of speed, you will want
to worry less about comprehension and more on just following the text with your eyes. Then back down to
something a little faster than your original Base Reading Speed. You'll typically find that it will seem very
readable, even though it is faster than your original speed. Then try it again, increasing your pace to higher
and higher speeds in this fashion.

Example of Recommended Training Technique: For the sake of an example, let's say your Base Reading
Speed (determined by taking a Self-Paced Reading Comprehension Test) is 100 words/minute. You would
want to practice reading at 100 words/minute, then 200 words/minute and then 300 words/minute. Then you
would back down to 120 words/minute. In this example, the 120 words/minute will seem very readable, even
though it is faster than your original Base Reading Speed. Once you feel comfortable at 120 words/minute, you
can repeat the process with higher and higher speeds.

Below is a list of features that will be useful when using AceReader Pro as a Self-Improvement
Educational Tool:

Bursting (Front Screen Features):

You can use the Burst feature to read a set number of words or sentences at your current speed before
stopping and you can customize the amount of text that is displayed. Refer to the "Set Burst Options" sub-
section within the "Options Menu" section for more detail on configuring this feature. One way to use the
Burst feature is to set the speed high and also to set some fine tune speed options (i.e. Long Word Delays).
You can quickly burst through chunks of text, then, depending on your comprehension, you can press the
"Forward” and/or "Repeat" Burst buttons to continue your reading.

Clipboard:
You can use the clipboard as a tool to load text from other applications (i.e. your favorite word processor,
Web browser, e-mail client, etc.).

Custom Options:
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You can save your current option settings under a name of your choice. Then, whenever you want to
return AceReader Pro to those settings, you can simply select that custom option. You may find this useful
if you like to use different option settings for different reading material or if you want to train in several
different modes.

Educational Mode Default Option Settings:

You can select a preset educational mode from the "Educational Mode Default Option Settings" submenu
found under the "Preset-Options" menu. Selecting any of the menu items found under the "Preset-Options
menu will set all the program options. After you choose an educational mode you can make further
adjustments by going to the "Options" menu.

Estimated Completion Time (Front Screen Feature):
You can estimate how long it will take you to complete the current document by giving this front screen
indicator your current position and speed setting. This can help you manage your reading time.

Eye Trainer Mode:

You can use the Eye Trainer Mode to force your eyes to move left-to-right and top-to-bottom, just as you
would do in normal reading. In this mode, you are forced to keep reading ahead because surrounding
text is not visible. This mode helps you break the bad habit of “regression” (letting your eyes wander back
to re-read text). Practicing to read in this mode will help you become a better reader both online and offline.

Load Comprehension Test Story:
You can load comprehension story material without taking the actual comprehension tests.

Load Drill Text:

You can load drill reading material without performing the actual drills.

Other Options Settings:

You can choose from many other options to make your online reading experience more efficient and
enjoyable: (1) font color; (2) font size; (3) background color; (4) display mode; (5) fine tune speed options
(i.e. delays) and much more. You will find all these options under the "Options" menu.

Read Timer (Front Screen Feature):

You can ensure you practice reading for certain periods of time by using the Read Timer feature. It keeps
track of actual read time. It can be reset at any time by pressing the small reset button next to the read
time display.
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General Usage

General Usage Overview

To get familiar with the main screen, refer to the section titled Main Screen Navigation. For detailed
explanations of how to perform certain tasks, refer to the following sections:

* How To Start and Stop Flashing Text
* Using Hotkeys
* Positioning Methods
* Positioning Methods Overview
* Using Bookmarks
* How To Load/Save Reading Material
* How To Load/Save Reading Material Overview
* Using the Clipboard
* Customizing AceReader Pro
* Selecting Preset Options
* Manually Setting Options
e Setting Up the Text Display Area
* Setting Text Flash Rate
* Setting Burst Options
* Mapping Your Own Hotkeys

How To Start and Stop Flashing Text

There are several ways to start and stop flashing text.

Stop/Play buttons:
When you click the Play button n the text will start flashing. Text will continue to flash until either you
click the Stop button i

or you reach the end of the document.

Note: The Start and Stop buttons are mapped to hotkeys. Refer to Mapping Your Own Hotkeys.

Burst-N-Stop buttons:

BURST-N-STOP

When you click the Burst buttons, text will start flashing. Text will continue to flash until you click the Stop

button . until the "burst amount" of text has been displayed or until you've reached the end of the
document.

The "burst amount" is defined in terms of "number of sentences," or "number of words.” Refer to Setting
Burst Options for more information.
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You can use the Burst feature to read a set the amount of text at your current speed before stopping and
you can customize the amount of text that is displayed. This is useful both for practicing and for quickly

skimming through text. Set the speed high. Then, when the text stops flashing, you can reflect on what
you just read before manually deciding if you want to proceed or re-read previous text.

Repeat:
The Burst Repeat button allows you to go back in the document to re-read the "burst amount" of text
you just completed (repositioned 1 x "burst amount” of text). At that point, the text will start flashing
until the "burst amount" has been displayed.

Forward:
The Burst Forward button allows you to start reading at your current position. It flashes a "burst
amount" of text before stopping.
Note: The Burst buttons are mapped to hotkeys. Refer to Mapping Your Own Hotkeys for more
information.

Manual Mode:

MANUAL MODE

Click on the Manual Back (left arrow) or Manual Forward (right arrow) to manually scroll back or forward
one word set. The green and red buttons above the Manual Forward button allow you to turn on and off
the manual timer. The manual mode buttons allow you to self pace yourself and the timer will keep track of
your speed (in words/minute).

Using Hotkeys

Hotkeys enable you to access commonly used functions using a series of keystrokes rather than using the
mouse.

You can configure the key-to-function mapping to suit your preference. Refer to: Mapping Your Own Hotkeys
for more information.

The following table is a list of the functions with their default hotkey equivalent:

Function Default Hotkey
Load Clipboard Commnad V
Hide/Show Top Controls Toggle Command D
Hide/Show Bottom Controls Toggle Command Shift D
Faster Speed (one speed bar unit) Page Up

Slower Speed (one speed bar unit) Page Down
Faster Speed (one speed unit) Up Arrow

Slower Speed (one speed unit) Down Arrow
Stop/Play Toggle Space Bar

Page Back Shift ,

Page Forward Shift .

Back Shift Left Arrow
Forward Shift Right Arrow
Set Bookmark Commnad B

Go To Bookmark Command Shift B
Sentence Search S

Burst Repeat ,
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Burst Forward .
Manual Forward Right Arrow
Manual Back Left Arrow

Positioning Methods

Positioning Methods Overview
There are several ways to move to locations in the document.

Text Slider:

Use this slider bar to adjust your current position in the document. This is useful for moving to approximate
locations (i.e. you may want to position to the middle of the document, then search for a word or sentence).

Page Back:

If the current mode is set to: Center Text, Upper Left or Eye Trainer then this button will scroll back one
word set.

If the current mode is set to: Unformatted Page or Formatted Page then this button will scroll back one
page.

Page Forward:

If the current mode is set to: Center Text, Upper Left or Eye Trainer then this button will scroll forward one
word set.

If the current mode is set to: Unformatted Page or Formatted Page then this button will scroll forward one
page.
Back:

If the current mode is set to: Center Text, Upper Left or Eye Trainer then this button will scroll the first word
back one word. This is useful for fine-tuning your position when setting bookmarks.

If the current mode is set to: Unformatted Page or Formatted Page then this button will scroll back one line
(defined by newlines in the input source).

Forward:

If the current mode is set to: Center Text, Upper Left or Eye Trainer then this button will scroll the first word
forward one word. This is useful for fine-tuning your position when setting bookmarks.

If the current mode is set to: Unformatted Page or Formatted Page then this button will scroll forward one
line (defined by newlines in the input source).

Go To Bookmark:

Click this button to move to a bookmark.
Note: For more details on using Bookmarks, refer to: Using Bookmarks.
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Sentence Search:

Click this button to move to the beginning of the next sentence containing the word(s) entered in the
[type... here |text box.

Using Bookmarks

Bookmarks allow you to mark certain places within the text so you can return to those locations quickly and
easily.

Set Bookmarks:

Click this button to set a bookmark at the current location. You will be prompted for a bookmark name.

Note: The Scroll 1% Word Back and Scroll 1 Word Forward buttons - are helpful for exact positioning
when setting bookmarks.

Go To Bookmarks:

Click this button to go to a previously set bookmark. If there is only one bookmark in the current document,
you will be positioned to that bookmark. If more than one bookmark exists, you will be presented with a list
from which to select.

Load File and Go To Bookmark:
Click the File menu item: Load File and Go To Bookmark. This function allows you to load a file and to
position to the bookmark of your choice.

Removing Bookmarks:
Click the File menu item: Remove Bookmarks. This function allows you to remove bookmarks.

How To Load/Save Reading Material

How To Load/Save Reading Material Overview
Open:
Click the File menu item: Open... This function allows you to load a plain text file from disk..

Note: The best way to read non-text documents (i.e. documents created by word processor) is to use the
Edit/Paste function.

Note: You may want to check out http://www.stepware.com/etext.html for links to e-text and e-books.

Open Recent:
Hilight the File menu item: Open Recent. This will reveal up to five of the most recent opened files.

Paste:
Click the Edit menu item: Paste. This function allows you to load AceReader Pro with the contents of the
clipboard. You can use the clipboard as a tool to read new and interesting material. This simple but

powerful feature allows you to load text from other applications (i.e. your favorite word processor, Web
browser, e-mail client, etc.).

Note: For a detailed explanation on how to use the clipboard, see the Using the Clipboard section.
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Note: You may want to check out http://www.stepware.com/etext.html for links to e-text and e-books.

Save As:

Click the File menu item: Save As. This function allows you to save any text you loaded into AceReader
Pro via the Load Clipboard function to your hard disk or to a floppy. You can then use the Load File
function to reload the text at a later time.

Note: You will not want to overwrite existing text files (unless they were created by a previous AceReader
Pro Save As function) since those files will lose their original text formatting. When you save files using
AceReader Pro, you should use them with AceReader Pro only.

Load Drill Text:
Click the File menu item: Load Drill Text. This function allows you to load reading material. While the

material is typically used when performing drills, this function provides a way of loading the material without
performing formal drills.

Note: You create Drill Text using the Drill Text Editor.

Note: The entries with the # character were provided at program install time; you cannot edit or delete
them.

Load Comprehension Test Story:
Click the File menu item: Load Comprehension Test Story. This function allows you to load comprehension
test stories. While the stories are typically used when taking comprehension tests, this function provides a
way of loading the material without taking formal comprehension tests.

Note: You create Comprehension Test Stories using the Comprehension Test Editor.

Note: The entries with the # character were provided at program install time; you cannot edit or delete
them.

Load File and Go To Bookmark:
Click the File menu item: Load File and Go To Bookmark. This function allows you to load a file that
already has bookmarks and it will automatically position the text to the bookmark of your choice. Refer to
the section Using Bookmarks for more information on how to use bookmarks.

Using the Clipboard

The clipboard is a simple but powerful feature built into your Macintosh operating system. It is simply memory -
-- a holding spot for data. You can use the clipboard to transfer data (i.e. text or images) from one application
to another. Almost all applications support it, including AceReader Pro. This section provides an example of
how to use the clipboard to transfer text from your Web browser into AceReader Pro. You should be able to
follow similar instructions to transfer text from other applications (i.e. e-mail program, word processor, etc.).
Use the following steps to copy text from your Web browser and paste it into AceReader Pro:
1. Within your Browser do the following:

A. Select text for clipboard - You can select text in either of two ways:

a) If you want to select all the text on the current Web page, go to the Edit Menu and click on the
"Select All"* option.

OR

b) If you just want a portion of the text on the current Web page, position your mouse at the beginning of
the text, left-click the mouse and hold it while dragging over the text to highlight it.
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Note: At this point you have selected (highlighted) the text, but you have not placed it in the clipboard.

B. Place selected text into clipboard - You place selected text into the clipboard in either of two ways
(both do the same thing):

a) Go to the Edit Menu and select the "Copy" option.
OR

b) Position your mouse over the highlighted text, right-click the mouse, then select the "Copy" option
from the popup menu.

Note: Now you have is loaded the text into the clipboard.

2. Within AceReader Pro do the following: Select the Paste option from the Edit menu. This will paste the
text into the program.
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Customizing AceReader Pro

Selecting Preset Options
The following preset options are available under the Preset-Options menu:

Original Option Settings:
This function allows you to reset all the options to the factory default (one word, center text mode, yellow
font on black background, etc.).

Productivity Mode Default Option Settings:
This function provides a list of preset productivity mode option settings. Productivity modes are useful
when you are trying to use AceReader Pro as a Productivity Tool.

Educational Mode Default Option Settings:
This function provides a list of preset educational mode option settings. Educational modes are useful
when you are trying to use AceReader Pro as a Self-Improvement Educational Tool.

Custom Option Settings:
This function provides a list of preset custom options. Refer to the section Custom Options Management
for more information on how to create your own custom options.

Note: The entries with the # character were provided at program install time; you cannot edit or delete
them.

Manually Setting Options

Setting Up the Text Display Area
The following options are available under the Options menu:

Set Font Style and Color:
This function allows you to select the font type, font size and font color for the text in the text display area.

Set Background Color:
This function allows you to select the color of the text display area.

Specify Number of Words or Lines:
This function allows you to specify the amount of text that you want to display each time the text display
area is updated. You can choose either (1) a partial single line or (2) a number of full lines to be displayed
at any one time. If you choose a partial single line, then you must specify how many words; if you choose
full lines, then you must specify the number of full lines.

Note: The specified number of words/lines represents the maximum number of words/lines shown on the
display area at any one time. An attempt will always be made to display the specified number of
words/lines, but because of other option settings (i.e. font size, margin settings, screen width/height, etc.),
the actual number of words/lines displayed at one time may vary. You may need to make some of these
other option settings smaller to achieve your desired result.

Hide/Show Top and Bottom Controls:
This function provides a mechanism for hiding or showing the top or bottom controls. These controls will
expand/shrink the text display area.

Note: If you hide the top or bottom controls, you can use the hotkeys to perform hidden control actions.
See section: Using Hotkeys for more information.

AraRaadar Prn (Mar \/arcinn) 2R



Top Controls:

b ﬂ :l Percent

Bottom Controls:

SET TARGET SPEED SENTENCE SEARCH :’ Last Actual WPM

m [:] Last Traditional Speed Compare
III I MANUAL MODE :I Average Actual WPM
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[: Completion ETA at Target Speed

[ 09:24 | Read Timer
[ 464 | Targetwpm BURST-N-STOP —EAceR“de .P ro

l

100

Fine Tune Options are OFF Electrify Your Mind

Stretching the Screen Size:
This function allows you to stretch or shrink the AceReader Pro main window. To accomplish this:

1.Position the mouse to one of the AceReader Pro main window edges until the mouse icon turns to a
double arrow.

2.While the mouse is a double arrow, left click the mouse button and keep it pressed down.

3.Move the mouse to expand or shrink the window.
Note: There is a limit to how much you can shrink the window, but you can expand it to the full size
of your monitor.

Margin Settings:
The Margin Tabs enable you to set the width of the text display area.

Note: Text will attempt to stay inside the margins. The only time text will show up outside the margin
setting is when a single word is wider than the margin width.

Margin Tabs:

[ — —
Setting Text Flash Rate

The rate that text is flashed on the screen will depend on your speed and fine tune speed option settings.
Note: The Target Speed and the Last Actual Speed may differ for several reasons: You may have adjusted
your speed while the text was flashing; you may have pressed the Stop button early (causing the timer to stop
early); or you may have fine tune speed options set. In addition, your computer’'s CPU; character vs. word-

based speed settings; and programs running in the background can all affect speed.

Front Screen Speed Control:
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SET TARGET SPEED

100

[:] Target WPM
|

Fine Tune Options are OFF

You can click on a speed bar or use the scroll slider bar. Moving the slider bar is the same as clicking on
the speed bar. Clicking on the left and right arrows allow you to adjust the speeding in terms of single
speed units.

Note: Refer to the Speed Options for configuring this front screen speed control. You can configure the
low, high and current target speeds.

Note: You will want to display more text on the screen (refer to Specify Number of Words or Lines) as you
increase the speed. For example, when flashing one word at a time, you may want to keep your speed
below 700 WPM. When flashing two words at a time, you may want to keep your speed below 800 WPM.
You should be flashing full lines when attempting to go at higher speeds (i.e. 900 WPM).
Speed Options:
This function allows you to configure the front screen speed control. You can specify:
* Target Speed units: WPM (Words per Minute), CPS (Characters per Second) or CPM (Characters
per Minute). You may want to use a character-based speed if you want long words to display for a
longer period than short words.
Note: If you select a character-based speed, you will probably want to set the Flash rate delay to
"Variable." See the Set Delays menu item for setting the Variable/Fixed Flash Rates option for more
information.
* Low Speed: The speed value of the lowest speed bar on the front screen.
* High Speed: The speed value of the highest speed bar on the front screen.

e Current Speed: The current target speed setting.

Note: You can adjust this value from the front screen by clicking on the speed bars and/or using the
speed slider bar.

Fine Tune Speed Options:

These options allow you to fine tune your speed (rate at which the text display area is updated).

Fixed Rate:
Set the flash (or text display update) rate to be constant.

The flash rate is determined from the first few flashes and will vary depending on the speed and the
amount of text being displayed.
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Since the amount of text shown in each screen update can vary, your reading speed should also vary if
you want to maintain your Target Speed. There are several reasons why the amount of text shown in
each screen update may vary. For example, you may be flashing three lines per screen update, but
when the flashing text reaches the bottom of the text display area there is only enough room to show
two lines. In addition, font size setting, margin width settings, text display area size and word lengths
can all affect the amount of text shown.

Note: You probably don’t want this option set if you are using a “character based” speed setting (i.e.
Characters Per Second or Characters Per Minute) since character based speeds are designed to vary
the speed depending on the number of characters shown on each display update.

Long Word Delays:
Delay a specified number of milliseconds (ms) if words are encountered that contain the specified
number of characters.

Sentence Ending Delays:
Delay a specified number of milliseconds (ms) if an end of sentence punctuation mark is encountered.

Punctuation Delays:
Delay a specified number of milliseconds (ms) if a punctuation mark is encountered.

Beginning of Line Delays:
Delay a specified number of milliseconds (ms) when displaying the beginning of a line. This provides
time for your eyes to reposition from the end of previous line to the beginning of the next line.

Beginning of Page Delays:
Delay a specified number of milliseconds (ms) when displaying the beginning of a page (text that fits on
text display area). This provides time for your eyes to reposition from the bottom of the text display
area to the top.

Minimum Delay:
Ensure that the text is always shown for a minimum amount of time. This is useful in cases where a
small amount of text is shown and you don’t want it to flash by too fast.

Note: The Target Speed and the Last Actual Speed may differ for several reasons: You may have adjusted

your speed while the text was flashing; you may have pressed the Stop button early (causing the timer to

stop early); or you may have fine tune speed options set. In addition, your computer’s CPU; character vs.
word-based speed settings; and programs running in the background can all affect speed.

Setting Burst Options

For a general usage description of how to use the Burst buttons on the front screen, refer to the How To Start
and Stop Flashing Text section.

Set Burst Options:

This Options Menu function allows you to specify the amount of text that is displayed before stopping. You
can specify the amount of text in terms of sentences and words.

Mapping Your Own Hotkeys

Hotkeys enable you to access commonly used functions using a series of keystrokes rather than using the
mouse. For a general usage and default hotkey definitions, refer to: Using Hotkeys.

Map Keys:
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This Options Menu function allows you to assign (map) keyboard keys to common functions. You will need
to highlight a function and a Key and then press the "Map Selected Function with Selected Key" button.

Note: You can return all the hotkeys back to their defaults by clicking on the "Reset All" button.
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Performing Administration Functions

Administration Overview

AceReader Pro is highly customizable. Administration functions include the ability to perform user
management; specify Custom Options; and import Drill Text, Drills and Comprehension Tests. You can set the
program up to be used the way you want.

To learn more about the different areas of administration see the appropriate section:
* User Management
e Custom Options Management
e Drill Management
e Comprehension Test Management
* Game Text Management
* Miscellaneous Options

User Management

The administrator can perform the following User Management activities, located under the Admin menu:

Clear Individual or All User Comprehension Test Results:
This function allows you to clear comprehension test results.

Note: This will permanently remove the test result history from the database.

Export User Comprehension Test Results:
This function allows you to export the comprehension test results to a file on your disk. This is useful if you
want to further process the test results data (i.e. using a spreadsheet program) or if you want to print the
data.

Note: You can specify filters by clicking the Filter Options... button. Filter options allow you to filter out
certain test results. Examples of test results that you may want to filter out: (1) test results for tests that
have been repeated, (2) test results for tests that have been previously canceled, (3) test results for self-
paced tests that indicate extremely low or extremely high reading speeds (i.e. user was distracted or
walked away from program or quickly clicked the Done button while the story was being presented during a
self-paced reading comprehension tests)... The default setting is recommended and will help you monitor
valid test results over time.

Note: You can specify if you want the data fields to be separated by tabs or by commas.
Note: If you want to view or print this data it is recommended that you load this file into a spreadsheet
program. When loading/importing the file into your spreadsheet program you will want to specify the field

delimiter you used during the export operation. The field delimiters allow all your data to be lined up in
columns of the spreadsheet.

Custom Options Management

The Custom Options Management functions enable you to Add, Replace and Remove Custom Options. You
can also Create, Duplicate, Remove, Import and Export Custom Option Sets.

Note: Set names that begin with the special "#" character are sets that came with the original installation and
are Read-Only. You are not allowed to change these sets, but you can duplicate them and then make changes
to the duplicated versions.

The administrator can perform the following Custom Options Management activities, located under the Admin

menu:
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Add Custom Option Setting:
This function allows you to create and replace Custom Options.

Before selecting this menu item, you will need to set all the options. You may find it useful first to select an
existing, preset option under the Preset-Options menu that is close to what you want. Then you can
manually make changes to any of the options found under the Options menu. The speed and screen size
are included as part of the option settings. Once you have all the options the way you want, use the Add
Custom Option Setting to add or replace an entry in an existing Custom Options Set.

After you have created the custom options, any and all program users can select them (via the Custom
Option Settings menu item). The custom options can also be used when defining drills (refer to: Drill
Management).

Remove Custom Option Setting:
This function allows you to remove individual Custom Options entries from existing Custom Option Sets.

Create New Custom Options Set
This function allows you to create a new Custom Options Set. When you create a new set, it remains
empty until you add new entries. Refer to Add Custom Option Setting on how to add entries to the new set.

Duplicate Custom Options Set
This function allows you to duplicate an existing Custom Options Set. You may want to duplicate an
existing set if you want to create a similar new set (i.e. you may want to duplicate and modify one of the
sets that came with the initial installation).
To create a similar set, first duplicate an existing set and then modify the entries in the new set by adding,
replacing and removing entries.

Remove Custom Options Set
This function allows you to remove an existing Custom Options Set.

Import Custom Options Set
This function allows you to import an existing Custom Options Set. The import/export functions allow
AceReader Pro users to share custom content.

Export Custom Options Set

This function allows you to export an existing Custom Options Set. The import/export functions allow
AceReader Pro users to share custom content.

Drill Management

The Drill Management functions enable you Remove and Import Drill Sets.

Note: Set names that begin with the special "#" character are sets that came with the original installation and
are Read-Only.

The administrator can perform the following Drill Management activities, located under the Admin menu:
Remove Drill Set

This function allows you to remove an existing Drill Set.
Import Drill Set

This function allows you to import an existing Drill Set. The import/export functions allow AceReader Pro
users to share custom content.
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Comprehension Test Management

The Comprehension Test Management functions enable you to remove and import Comprehension Test Sets.

Note: Set names that begin with the special "#" character are sets that came with the original installation and
are Read-Only.

The administrator can perform the following Comprehension Test Management activities, located under the
Admin menu:

Remove Comprehension Test Set
This function allows you to remove an existing Comprehension Test Set.

Import Comprehension Test Set

This function allows you to import an existing Comprehension Test Set. The import function allows
AceReader Pro users to share custom content.

Game Text Management

The Game Text Management functions enable you to Remove and Import Game Text.

Note: Game Text names that begin with the special "#" character came with the original installation and are
Read-Only.

The administrator can perform the following Game Text Management activities, located under the Admin menu:

Remove Game Text
This function allows you to remove Game Text.

Import Game Text

This function allows you to import existing Game Text. The import/export functions allow AceReader Pro
users to share custom content.

Set Base Reading Speed Options

Your Base Reading Speed (BRS) is determined from your most recent "qualified" self-paced reading
comprehension test result. Your Base Reading Speed is the speed in which you read the story while taking the
test. Testresults are "qualified" using filter criteria specified on this screen.

Miscellaneous Options

Lockout ability to load Comprehension Test Stories from File menu

When this option is set, you are not allowed to load test stories from the File menu (within the Online
Reader & Expert Mode screen). When this option is set, you will not have an opportunity to get familiar
with test stories before taking reading comprehension tests.

Typically, you will want to keep this option set unless you want access to the reading comprehension test

stories from the Online Reader & Expert Mode screen and you are not concerned about reading
comprehension test results.
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MAIN SCREEN AND MENU QUICK REFERENCE

Main Screen Quick Reference

The following main screen will appear after you start AceReader Pro and enter the Online Reader & Expert
Mode. To get acquainted with the main screen, you can refer to the section in the Help titled "Main Screen
Quick Reference Overview." That section contains a picture of the main screen.

When your mouse is positioned over an item on the picture, the cursor will change to a hand icon ‘&'. You can
then left click on the mouse to get a short description of that item.

The following is an example of what is displayed when you left click on the Set Bookmark button:

-lalx]

File Options Preset-Options Tests-Drills-Games Admin  Help

File: example.txt (488 Words)

Read Faster!

[ ]

S g
Set Bookmark
SET TARGET SPEED SENTENCE SEARCH Click this button to set a bookmark.

m Last Traditional Speed Compare
II| ‘ I MANUAL MODE
600

[ 523 | Average Actual WPM

|:] Completion ETA at Target Speed

100 :l Read Timer

[(464 ] Targetwpm BURST-N-STOP —AceReader'Pro
] | Electrify Your Mind

Fine Tune Options are OFF
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Menu Quick Reference Overview

The AceReader Pro menu command reference section provides a comprehensive listing of each menu item. It
is not intended as a comprehensive how-to for each menu command, but rather as a quick reference. You will
find the following information for each menu command:

Menu Item: Name of the menu item.
Purpose: A short description of the menu item’s purpose.

How to Access:  The series of mouse clicks, along with possible keyboard shortcuts, used to invoke the
menu command.

See Also: Related help topics that indicate where to go to find more details on how to use the
functionality of this menu item and why.

File Menu Quick Reference

Open
Menu Item: Open
Purpose: Enables you to load plain text files from disk into AceReader Pro.

How to Access: Click File menu
Click Load File

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

See Also: How To Load/Save Reading Material Overview
Open Recent

Menu Item: Open Recent
Purpose: Enables you to load a previously loaded file from disk into AceReader Pro .

How to Access: Click File menu
Click Open Recent

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

See Also: How To Load/Save Reading Material Overview
Save As
Menu Item: Save As
Purpose: Enables you to save the currently loaded document to a file.

How to Access: Click File menu
Click Save As

AreReadear Prn (Mar \/arcinn) 7



See Also:

Load Dirill Text

Menu ltem:

Purpose:

How to Access:

See Also:

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

How To Load/Save Reading Material Overview

Load Drill Text

Enables you to load Drill Text created using the Drill Text Editor so that you can read the
text without performing a formal drill.

Click File menu
Click Load Drill Text

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

How To Load/Save Reading Material Overview

Load Comprehension Test Story

Menu ltem:

Purpose:

How to Access:

See Also:

Load Comprehension Test Story

Enables you to load stories created using the Comprehension Test Editor so that you can
read the story without taking the comprehension test.

Click File menu
Click Load Comprehension Test Story

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

How To Load/Save Reading Material Overview

Load File and Go To Bookmark

Menu Item:
Purpose:

How to Access:

See Also:

Load File and Go To Bookmark
Enables you to load a file and move to a bookmark position.

Click File menu
Click Load File and Go To Bookmark

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

How To Load/Save Reading Material Overview Using Bookmarks

Remove Bookmarks

Menu ltem:

Purpose:

Remove Bookmarks

Enables you to remove bookmarks associated with files.
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How to Access: Click File menu
Click Remove Bookmarks

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

See Also: Using Bookmarks

Quit
Menu ltem: Quit

Purpose: Enables you to close down the AceReader Pro program.

How to Access: Click File menu
Click Quit

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

See Also: N/A
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Edit Menu Quick Reference

Paste

Menu ltem:

Purpose:

How to Access:

See Also:

Paste
Enables you to paste previously copied text into AceReader Pro.

Click Edit menu
Click Paste
Note: Programmable hotkey (default is Command V)

How To Load/Save Reading Material Overview
Using the Clipboard

Using Hotkeys

Mapping Your Own Hotkeys
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Options Menu Quick Reference

Set Font Style and Color

Menu Item:
Purpose:

How to Access:

See Also:

Set Font
Enables you to select the font AceReader Pro will use when flashing text.

Click Options menu
Click Set Font

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Setting Up the Text Display Area

Set Background Color

Menu Item:
Purpose:

How to Access:

See Also:

Set Background Color
Enables you to set the text area background color.

Click Options menu
Click Set Background Color

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Setting Up the Text Display Area

Center Text Mode

Menu Item:
Purpose:

How to Access:

See Also:

Center Text Mode

Enables you to set the text display mode to RSVP mode.

Click Options menu

Click Center Text Mode

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Setting Text Flash Mode

Eye Trainer Scroll Mode

Menu Item:
Purpose:

How to Access:

Eye Trainer Scroll Mode
Enables you to set the text display mode to TSP mode.

Click Options menu
Click Eye Trainer Scroll Mode
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See Also:

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Setting Text Flash Mode

Specify Number of Words or Lines

Menu Item:
Purpose:

How to Access:

See Also:

Specify Number of Words or Lines
Enables you to set the number of words or lines of text to display in the text viewing area.

Click Options menu
Click Specify Number of Words or Lines

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Setting Up the Text Display Area

Set Speed Options

Menu ltem:

Purpose:

How to Access:

See Also:

Set Speed Options

Enables you to set up the front screen speed control by setting the low, high and target
speeds in terms of WPM, CPS or CPM.

Click Options menu
Click Set Speed Options

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Setting Text Flash Rate

Set Fine Tune Speed Options

Menu ltem:

Purpose:

How to Access:

See Also:

Set Fine Tune Speed Options

Enables you to set fixed speed and delays that will affect the rate at which text is flashed
on the screen.

Click Options menu
Click Set Fine Tune Speed Options

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Setting Text Flash Rate

Set Burst Options

Menu ltem:

Set Burst Options

AreReadear Prn (Mar \/arcinn) A9



Purpose:

How to Access:

See Also:

Set Map Keys

Menu Item:
Purpose:

How to Access:

See Also:

Enables you to set the amount of text to display before stopping when using the Burst
buttons on the main screen.

Click Options menu
Click Set Burst Options

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

How To Start and Stop Flashing Text
Setting Burst Options

Map Keys
Enables you to map keyboard keys to commonly used functions.

Click Options menu
Click Map Keys

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Mapping Your Own Hotkeys
Using Hotkeys

Hide/Show Top Controls

Menu Item:
Purpose:

How to Access:

See Also:

Hide/Show Top Controls
Enables you to hide or show the top controls.

Click Options menu
Click Hide Top Controls or Show Top Controls

Note: Programmable hotkey (default is F11)

Note: Icon on main screen. B (use top icon)

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Setting Up the Text Display Area
Using Hotkeys
Mapping Your Own Hotkeys

Hide/Show Bottom Controls

Menu ltem:

Hide/Show Bottom Controls
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Purpose: Enables you to hide or show the bottom controls.

How to Access:  Click Options menu
Click Hide Bottom Controls or Show Bottom Controls
Note: Programmable hotkeyédefault is F12)

Note: Icon on main screen. B (use bottom icon)

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

See Also: Setting Up the Text Display Area

Using Hotkeys
Mapping Your Own Hotkeys
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Preset-Options Menu Quick Reference

Original Option Settings

Menu Item:
Purpose:

How to Access:

See Also:

Original Option Settings
Enables you to reset all the options to factory default.

Click Preset-Options menu
Click Original Option Settings

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Selecting Preset Options

Productivity Mode Default Option Settings

Menu ltem:

Purpose:

How to Access:

See Also:

Productivity Mode Default Option Settings

Enables you to select from a list of pre-configured options settings designed for
Productivity use.

Click Preset-Options menu
Click Productivity Mode Default Option Settings

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Selecting Preset Options

Educational Mode Default Option Settings

Menu ltem:

Purpose:

How to Access:

See Also:

Educational Mode Default Option Settings

Enables you to select from a list of pre-configured options settings designed for
Educational use.

Click Preset-Options menu
Click Educational Mode Default Option Settings

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Selecting Preset Options

Custom Option Settings

Menu ltem:

Purpose:

Custom Option Settings

Enables you to select a custom option.
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How to Access:  Click Preset-Options menu
Click Custom Option Settings

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

See Also: Selecting Preset Options
Custom Options Management
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Tests-Drills-Games Menu Quick Reference

Take Comprehension Test (Self-Paced)

Menu Item: Take Comprehension Test (Self-Paced)
Purpose: Enables you to take a self-paced reading comprehension test.

How to Access: Click Tests-Drills-Games menu
Click Take Comprehension Test (Self-Paced)

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

See Also: Take Comprehension Test (Self-Paced)
Take Comprehension Test (Forced Speed/Mode)

Take Comprehension Test (Forced Speed/Mode)

Menu Item: Take Comprehension Test (Forced Speed/Mode)

Purpose: Enables you to take a reading comprehension test. Text presentation speed and mode are
pre-determined before taking the test.

How to Access:  Click Tests-Drills-Games menu
Click Take Comprehension Test (Forced Speed/Mode)

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

See Also: Take Comprehension Test (Forced Speed/Mode)
Take Comprehension Test (Self-Paced)
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View Comprehension Test Results

Menu Item:
Purpose:

How to Access:

See Also:

Perform Drills

Menu Item:
Purpose:

How to Access:

See Also:

View Comprehension Test Results
Enables you to view the results of your comprehension tests.

Click Tests-Drills-Games menu
Click View Comprehension Test Results

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

View Comprehension Test Results

Perform Drills
Enables you to perform Drills.

Click Tests-Drills-Games menu
Click Perform Drills

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Performing Drills

Play Eye-Span Game

Menu ltem:

Purpose:

How to Access:

See Also:

Play Eye-Span Game

The Eye-Span Game will help you: (1) Reduce Your Eye Fixation Time (time spent when
your eyes are focused on a single point); (2) Expand Your Eye Fixation Zone (ability to
read a wider text width when your eyes are focused on a single point); and (3) Increase
Your Re-Fixation Speed (ability to reposition your eyes at a rapid rate). These are skills
that are required to become a proficient reader.

Click Tests-Drills-Games menu
Click Play Eye-Span Game

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Play Eye-Span Game

Play Eye-Span Comprehension Game
Play Tachistoscope Flash & Recall Game
Play Flash Card Game

Play Search/Scan Game

Play Eye-Span Comprehension Game

Menu ltem:

Play Eye-Span Comprehension Game

AreReadear Prn (Mar \/arcinn) AR



Purpose: The Eye-Span Comprehension Game is similar to the Eye-Span Game except it has a
"Comprehension" element to it. It will help you increase your eye span and eye fixation
speeds while you are also being forced to think about the meaning of the words flashed on
the screen.

How to Access: Click Tests-Drills-Games menu
Click Play Eye-Span Comprehension Game

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

See Also: Play Eye-Span Game
Play Eye-Span Comprehension Game
Play Tachistoscope Flash & Recall Game
Play Flash Card Game
Play Search/Scan Game

Play Tachistoscope Flash & Recall Game

Menu Item: Play Tachistoscope Flash & Recall Game

Purpose: The Tachistoscope Flash & Recall Game will flash text for a short period of time. You will
then need to recall the text that was flashed. This game helps demonstrate how fast you
are able to read when presented with a short burst of text. It also increases your eye span
and eye fixation speed.

How to Access: Click Tests-Drills-Games menu
Click Play Tachistoscope Flash & Recall Game

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

See Also: Play Eye-Span Game
Play Eye-Span Comprehension Game
Play Tachistoscope Flash & Recall Game
Play Flash Card Game
Play Search/Scan Game

Play Flash Card Game

Menu Item: Play Flash Card Game

Purpose: The Flash Card Game is similar to the Tachistoscope Flash & Recall Game except it has a
"Comprehension" element to it. You can also use it to memorize learning materials such
as Times Tables, State Capitals... Note: As with all the Tests, Drills and Games, the
administration functions allow you to incorporate your own practice material into the
program.

How to Access: Click Tests-Drills-Games menu
Click Play Flash Card Game

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

See Also: Play Eye-Span Game
Play Eye-Span Comprehension Game
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Play Tachistoscope Flash & Recall Game
Play Flash Card Game
Play Search/Scan Game

Play Search/Scan Game

Menu Item: Play Search/Scan Game

Purpose: With the Search/Scan Game, you will search for a pre-specified word or symbol within a list
or body of text. Searching/Scanning is something we do many times in our daily lives (i.e.
looking up phone numbers, recipe ingredients, research...) and the game can help you
become more skilled at this common daily activity.

How to Access: Click Tests-Drills-Games menu
Click Play Search/Scan Game

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

See Also: Play Eye-Span Game
Play Eye-Span Comprehension Game
Play Tachistoscope Flash & Recall Game
Play Flash Card Game
Play Search/Scan Game
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Admin Menu Quick Reference

User Management

Clear Individual or All User Comprehension Test Results

Menu Item: Clear Individual or All User Comprehension Test Results
Purpose: Enables the Teacher or Administrator to clear user comprehension test results.
How to Access:  Click Admin menu

Click User Management sub-menu

Click Clear Individual or All User Comprehension Test Results

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

See Also: User Management

Export User Comprehension Test Results

Menu Item: Export User Comprehension Test Results
Purpose: Enables the Teacher or Administrator to export user comprehension test results.
How to Access:  Click Admin menu

Click User Management sub-menu

Click Export User Comprehension Test Results

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPORT MODE button.

See Also: User Management

Custom Options Management

Add Custom Option Setting

Menu Item: Add Custom Option Setting
Purpose: Enables the Teacher or Administrator to add custom options settings to an existing custom
options set.

How to Access:  Click Admin menu
Click Custom Options Management sub-menu
Click Add Custom Option Setting

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

See Also: Custom Options Management
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Remove Custom

Menu ltem:

Purpose:

How to Access:

See Also:

Option Setting

Remove Custom Option Setting

Enables the Teacher or Administrator to remove custom options settings from an existing
custom options set.

Click Admin menu
Click Custom Options Management sub-menu
Click Remove Custom Option Setting

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Custom Options Management

Create New Custom Options Set

Menu Item:
Purpose:

How to Access:

See Also:

Create New Custom Options Set

Enables the Teacher or Administrator to create a new set of custom options.
Click Admin menu

Click Custom Options Management sub-menu

Click Create New Custom Options Set

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Custom Options Management

Duplicate Custom Options Set

Menu Item:
Purpose:

How to Access:

See Also:

Remove Custom

Menu ltem:

Purpose:

Duplicate Custom Options Set

Enables the Teacher or Administrator to duplicate an existing custom options set.
Click Admin menu

Click Custom Options Management sub-menu

Click Duplicate Custom Options Set

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Custom Options Management

Options Set

Remove Custom Options Set

Enables the Teacher or Administrator to remove an existing custom options set.
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How to Access:  Click Admin menu
Click Custom Options Management sub-menu
Click Remove Custom Options Set

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

See Also: Custom Options Management

Import Custom Options Set

Menu Item: Import Custom Options Set
Purpose: Enables the Teacher or Administrator to import a custom options set.
How to Access:  Click Admin menu

Click Custom Options Management sub-menu

Click Import Custom Options Set

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

See Also: Custom Options Management

Export Custom Options Set

Menu Item: Export Custom Options Set
Purpose: Enables the Teacher or Administrator to export a custom options set.
How to Access:  Click Admin menu

Click Custom Options Management sub-menu

Click Export Custom Options Set

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPORT MODE button.

See Also: Custom Options Management

Drill Management

Remove Drill Set

Menu Item: Remove Drill Set
Purpose: Enables the Teacher or Administrator to remove an existing drill set.
How to Access:  Click Admin menu
Click Drill Management sub-menu
Click Remove Drill Set
Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.
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See Also:

Import Drill Set

Menu Item:
Purpose:

How to Access:

See Also:

Drill Management

Import Drill Set

Enables the Teacher or Administrator to import a drill set.
Click Admin menu

Click Drill Management sub-menu

Click Import Drill Set

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Drill Management

Comprehension Test Management

Remove Comprehension Test Set

Menu Item:
Purpose:

How to Access:

See Also:

Remove Comprehension Test Set

Enables the Teacher or Administrator to remove an existing comprehension test set.
Click Admin menu

Click Comprehension Test Management sub-menu

Click Remove Comprehension Test Set

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Comprehension Test Management

Import Comprehension Test Set

Menu Item:
Purpose:

How to Access:

See Also:

Import Comprehension Test Set

Enables the Teacher or Administrator to import a comprehension test set.
Click Admin menu

Click Comprehension Test Management sub-menu

Click Import Comprehension Test Set

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Comprehension Test Management
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Eye-Span Game Text Management

Remove Eye-Span Game Text

Menu Item:
Purpose:

How to Access:

See Also:

Remove Eye-Span Game Text

Enables the Teacher or Administrator to remove Eye-Span game text.
Click Admin menu

Click Eye-Span Game Text Management sub-menu

Click Remove Eye-Span Game Text

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Game Text Management

Import Eye-Span Game Text

Menu Item:
Purpose:

How to Access:

See Also:

Import Eye-Span Game Text

Enables the Teacher or Administrator to import Eye-Span game text.
Click Admin menu

Click Eye-Span Game Text Management sub-menu

Click Import Eye-Span Game Text

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Game Text Management

Eye-Span Comprehension Game Text Management

Remove Eye-Span Comprehension Game Text

Menu ltem:

Purpose:

Remove Eye-Span Comprehension Game Text

Enables the Teacher or Administrator to remove Eye-Span Comprehension game

text.

How to Access:

See Also:

Click Admin menu
Click Eye-Span Comprehension Game Text Management sub-menu
Click Remove Eye-Span Comprehension Game Text

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Game Text Management

Import Eye-Span Comprehension Game Text
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Menu Item: Import Eye-Span Comprehension Game Text

Purpose: Enables the Teacher or Administrator to import Eye-Span Comprehension game
text.

How to Access:  Click Admin menu
Click Eye-Span Comprehension Game Text Management sub-menu
Click Import Eye-Span Comprehension Game Text

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

See Also: Game Text Management

Tachistoscope Flash and Recall Game Text Management

Remove Tachistoscope Flash and Recall Game Text

Menu Item: Remove Tachistoscope Flash and Recall Game Text
Purpose: Enables the Teacher or Administrator to remove Tachistoscope Flash and Recall game
text.

How to Access:  Click Admin menu
Click Tachistoscope Flash and Recall Game Text Management sub-menu
Click Remove Tachistoscope Flash and Recall Game Text

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

See Also: Game Text Management

Import Tachistoscope Flash and Recall Game Text

Menu Item: Import Tachistoscope Flash and Recall Game Text
Purpose: Enables the Teacher or Administrator to import Tachistoscope Flash and Recall game text.
How to Access:  Click Admin menu

Click Tachistoscope Flash and Recall Game Text Management sub-menu

Click Import Tachistoscope Flash and Recall Game Text

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

See Also: Game Text Management

Flash Card Game Text Management

Remove Flash Card Game Text
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Menu Item:
Purpose:

How to Access:

See Also:

Remove Flash Card Game Text

Enables the Teacher or Administrator to remove Flash Card game text.
Click Admin menu

Click Flash Card Game Text Management sub-menu

Click Remove Flash Card Game Text

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Game Text Management

Import Flash Card Game Text

Menu Item:
Purpose:

How to Access:

See Also:

Import Flash Card Game Text

Enables the Teacher or Administrator to import Flash Card game text.
Click Admin menu

Click Flash Card Game Text Management sub-menu

Click Import Flash Card Game Text

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Game Text Management

Search/Scan Game Text Management

Remove Search/Scan Game Text

Menu Item:
Purpose:

How to Access:

See Also:

Remove Search/Scan Game Text

Enables the Teacher or Administrator to remove Search/Scan game text.
Click Admin menu

Click Search/Scan Game Text Management sub-menu

Click Remove Search/Scan Game Text

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

Game Text Management

Import Search/Scan Game Text

Menu ltem:

Purpose:

Import Search/Scan Game Text

Enables the Teacher or Administrator to import Search/San game text.
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How to Access:  Click Admin menu
Click Search/Scan Game Text Management sub-menu
Click Import Search/Scan Game Text

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPERT MODE button.

See Also: Game Text Management

Set Base Reading Speed Options

Menu Item: Set Base Reading Speed Options
Purpose: Allows you to filter out certain test results when determining your Base Reading Speed.

How to Access:  Click Admin menu
Click Set Base Reading Speed Options sub-menu

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPORT MODE button.

See Also: N/A

Miscellaneous Options

Menu Item: Miscellaneous Options
Purpose: Provides additional administrative options.

How to Access:  Click Admin menu
Click Miscellaneous Options sub-menu

Note: If Wizard Screen is showing, then you must first click on the ONLINE READER &
EXPORT MODE button.

See Also: N/A
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Help Menu Quick Reference

Menu Item:
Purpose:

How to Access:

See Also:

Start Wizard

Menu Item:
Purpose:

How to Access:

See Also:

Tip of the Day

Menu Item:
Purpose:

How to Access:

See Also:

Order Web Page

Menu Item:
Purpose:

How to Access:

See Also:

Menu ltem:

AceReader Pro Help

AceReader Pro Help
Enables the user to bring up online help.

Click Help menu
Click AceReader Pro Help

N/A

Start Wizard
Start Wizard Screen.

Click Help menu
Click Start Wizard

N/A

Tip of the Day
Enables user to bring up the Tip of the Day dialog box.

Click Help menu
Click Tip of the Day

N/A

Order Web Page

Enables user to access the AceReader secure online order page.

Click Help menu
Click Order Web Page

Order Information
Printable Order Form

Hide Button Tips/Show Button Tips

Hide Button Tips/Show Button Tips
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Purpose: Enables/Disables mouse-over button information on the main screen.

How to Access:  Click Help menu
Click Hide Button Tips
Click Show Button Tips
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APPENDIX A — Offline Readinqg Tips

One of the most important and the most helpful, reading aids is known as previewing. Previewing gives you a
sense of the material -- such as topic, level of difficulty, author’s style and length -- before you actually sit down to
read it. It allows you to decide whether or not you want or need, to spend the time reading the entire passage to
obtain more of the details. In short, it allows you to become a more efficient and effective reader.

Use the following steps to preview:

1. Establish a purpose for reading this material. Have a specific reason for reading the material, whether the
motivation comes from within or without. You'll vary your approach and techniques to achieve that outcome.

2. Study the title, headings and subheadings. The give you a quick cue as to what the topic of discussion will
be. They may also be a deciding factor in determining your purpose and establishing your course of action.

3. Look at the first and last paragraphs. These can provide you with a quick introduction and conclusion of the
material contained in the main part of the text.

4. Look for bold-faced, italicized and underlined words. These are words or ideas that the author thought were
important enough to highlight for you. A quick overview of these words will give you a sense of where the author is
heading with the material.

5. Look at the visual aids. Graphs, charts, diagrams, maps and illustrations all provide support for what's in the
main part of the text. They create a vivid mental picture of the people, things and ideas under discussion. They
can also provide a quick grasp of the relationships between the data or other concepts in the main part of the text.

You should preview everything you read, regardless of its complexity or length. Here are some suggestions for a
couple different types of material:

General non-fiction/textbooks -

1. Look at the organization. There are usually chapters, sections, a table of contents and an index. Look for
chapter headings and key subheadings.

2. Look at the chapters. Individual chapters may have their own index/overview and summary/content questions.
3. Look at the beginning and end of sections. The most important information is usually contained there, with
details in the middle part.

4. Look at the setup of diagrams, pictures, graphs, etc.

5. Read the book’s preface/introduction for an overview of the author’s purpose and content.

6. Within the chapters, preview the introductions, summaries, charts, etc. Decide if you need to read for more
details.

Letters and Memos -

1. Consider the setup. The opening and closing paragraphs are usually cordialities and contain little vital
information.

2. Head to the important parts. The earlier and later middle paragraphs contain the most important information.
3. Look at who sent it, the date sent, if there’s a “re:” line and who else received it.

4. Skim or read the middle paragraphs to get details and decide appropriate response.

News -

1. Consider the organization. News is usually organized in an inverted pyramid -- the most important information is
first, then the details, in order of importance.

2. Read the first and last paragraphs for an overview and the conclusion.

3. Look at the graphs, diagrams, etc. and decide if it's worth taking the time to read the rest of the article.
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GLOSSARY

NOTE: Refer to this section for words throughout the document that have been marked in Italics.

AceReader Pro Menu Options

These are the menu options that allow you to load text, set options, select preset options, perform drills and take
comprehension tests. The Admin menu is available to the Admin user and provides access to administration
functions.

Average Actual WPM

This window displays a running total of the average rate at which text has been flashing in the text display area.

Average Actual WPM Reset

This button will reset the running Average Actual WPM (words per minute) indicator.

Base Reading Speed

Your Base Reading Speed (BRS) is determined from your most recent “qualified” self-paced reading
comprehension test result. Your Base Reading Speed is the speed in which you read the story while taking the
test. Testresults are “qualified” using criteria specified by Admin options. Note: Drills may utilize your BRS to
determine how fast to pace you.

Burst Back

This button allows you to re-read text prior to the text that just completed flashing. The amount of text flashed
before stopping is configurable and is specified in terms of words or sentences.

Burst Forward
This button allows you to read the next burst amount of text. The amount of text flashed before stopping is
configurable and is specified in terms of words or sentences.

Burst Repeat
This button allows you to re-read the text that just completed flashing. The amount of text flashed before stopping
is configurable and is specified in terms of words or sentences.

CPM (Characters per Minute)

Text flash rate in terms of "Characters per Minute."

CPS (Characters per Second)

Text flash rate in terms of "Characters per Second."

Drill Author
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The person who created the drill using the Drill Editor.

Drill Text

The reading material used by the drills.

Estimate Completion Time
This window displays the estimated time it will take to complete the currently loaded document. It is based on your
target speed setting and your location in the document.

Expand Your Eye Fixation Zone
The ability to read a wider text width when your eyes are focused on a single point.

Filename
The name of the current file.

Go to Bookmark

This button allows you to go to a bookmark. If only one bookmark exits for the current document, then you will
automatically be positioned to that bookmark. If more than one bookmark exists, then you will be presented with a
list of bookmarks from which to select.

Hide or Show Bottom Controls
This button allows you to toggle between hiding and showing the bottom controls. The bottom controls are located
just below the top controls and include the speed controls, Sentence Search controls, burst controls and statistics.

Hide or Show Top Controls

This button allows you to toggle between hiding and showing the top controls. The top controls are located just
below the text display area and include the stop button, start button, position slider, forward/back word set buttons,
forward/back 1st word buttons, bookmark buttons and the percent indicator.

Increase Your Re-Fixation Speed
The ability to reposition your eyes at a rapid rate.

Last Actual WPM

This indicator displays the true speed at which text was flashed during the last start/stop session. Note: The true
speed can vary depending on many factors, including: whether or not you have delays enabled, whether or not you
have the variable speed option set, any background programs you have running, whether or not you hit the stop
button early, whether or not you made on-the-fly speed adjustments, etc.

Last Traditional Speed Compare

This window displays your speed during the last start/stop session in terms of a factor indicating how fast the text
was displayed relative to the average traditional reading speed (250 words per minute). For example, if the window
displayed 2.0 X, then it means that you just read two times the average traditional reading speed (i.e. 500 words
per minute).

Level
This term is equivalent to "grade level." The grade levels were determined using the readability statistics tool
provided in both the Drill Text Editor and the Comprehension Test Editor.

Main Screen Mode

In main screen mode, text is flashed on the text display area using all the current speed and option settings. This
mode is recommended if you want to test your comprehension while being forced to read at certain speeds and
modes.
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Margin Tab

These slider bars allow you to set the text display width.

millisecond (ms)
One-thousandth of a second.

Normal Reading Mode

In normal reading mode text remains static, just as it does when you read a book or any other printed matter. The
reader is self-paced. This mode is recommended if you are trying to determine your true and current base reading
speed.

Percent
This window displays your current position (as a percentage of total text) in the document.

Play Button

This button allows you to start flashing text at the configured speed.

Productivity Tool

This tool helps you read better and faster while online.

Read Timer/Alarm
The read timer keeps track of your actual read time. It can be configured to an amount of time in terms of minutes
and/or seconds. The read timer counts down; when it reaches zero, it sounds an alarm.

Read Timer/Alarm Reset
This button will reset the read timer.

Reduce Your Eye Fixation Time
Reduce time spent when your eyes are focused on a single point.

Re-Reading

Letting your eyes wander back so that you re-read text you previously encountered. Also known as regression.

RSVP (Rapid Serial Visual Presentation)

RSVP refers to a text presentation mode. When text is flashing in RSVP mode, text is displayed in the center of the
text area. This allows you to read faster than normal because your eyes do not need to move. In RSVP mode, the
words come to your eyes instead of your eyes going to the words.

Scroll Back Word Set

This button allows you to scroll backward one word set. A word set is defined as the amount of text that is shown
on the screen at one time.

Scroll First Word Back

This button allows you to scroll the first word back one word.

Scroll First Word Forward

This button allows you to scroll the first word forward one word.

Scroll Forward Word Set

This button allows you to scroll forward one word set. A word set is defined as the amount of text that is shown on
the screen at one time.
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Self-Improvement Educational Tool
This tool helps you learn to be a more proficient reader both online and offline

Sentence Search

This button allows you to search and position to the next occurrence of a sentence containing the word(s) you
entered in the Sentence Search Input Box. You will be positioned to the first word of a sentence that contains the
word(s) you are searching for.

Set Bookmark
This button allows you to set a bookmark.

Speed Graph
This graph displays your target speed graphically. You can click anywhere on the graph to change your target
speed. Note: The low and high speeds are configurable.

Stop Button

This button allows you to stop flashing text.

Sub-vocalization
Pronouncing the words in your mind as you read.

Target Speed
This window displays your current target speed in terms of WPM (Words per Minute), CPS (Characters per
Second) or CPM (Characters per Minute).

Target Speed Slider

This slider bar allows you to set your target speed. The slider bar will do the same thing as clicking on the bars.
The left and right arrows will allow you to fine-tune your target speed. Note: The low and high speeds are
configurable.

Text Display Area

The area where text is displayed.

Text Slider

This slider bar allows you to adjust your current position in the document.

TSP (Tachistoscopic Scroll Presentation)

TSP refers to a text presentation mode. When text is flashing in TSP mode, it is displayed in a manner that forces
your eyes to move like they do in normal reading (left-to-right and/or top-to-bottom). TSP mode can be used to
train you to read in a normal fashion at higher speeds.

Word Set

The amount of text shown on the screen at one time.

WPM (Words per Minute)

Words per Minute speed unit.
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CONTACT US

Technical Support

If the online help and AceReader Web site have not addressed your issue(s), contact StepWare, Inc. in any of the
following ways:

E-Mail
support@stepware.com

US Mail

StepWare, Inc.

320 Dakota Drive

Grand Junction, CO 81503

Telephone
970-243-9390

FAX
970-243-9482
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